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President’s Message 
 

February might be short, but it’s a great month to keep our 
photography momentum going. Winter light, snowy 
textures, and indoor creativity all give us plenty to work 
with, and it’s exciting to see how members continue to find 
inspiration this time of year. 
  
This month we’ll be connecting through 
our February program, image sharing, and critique 
opportunities, along with our monthly challenge theme of 
headshots and our Metal Competition. These are great 
chances to learn from one another, try something new, 
and see familiar subjects in a different way. Whether 
you’re shooting outdoors in the cold or experimenting 
inside, every image is part of the journey. 
  
Thank you to everyone who participates, volunteers, and 
helps make the Saskatoon Photography Club such a 
welcoming and supportive community. I’m looking 
forward to another great month of learning, creativity, and 
conversation. 
  
Stay warm and keep shooting! 
 
Cheers, 
Maurice Vold 
President, Saskatoon Photography Club 
president@saskatoonphotographyclub.com 
  
https://www.saskatoonphotographyclub.com/ 
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POST-PROCESSING 
Luminosity Masks in Photoshop 

 
 

Quick lesson for photographers 

 

Precision control of exposure, color, and tone — using selections based on brightness values 
(light itself). 

Why this matters: Luminosity masks let you target highlights, midtones, or shadows with 
smooth falloff—so edits stay natural, realistic, and free of halos. 

In this issue 
• What a luminosity mask is (and why it looks invisible when done right) 

• When to use luminosity masks 

• Creating masks manually (Lights, Darks, Midtones) 

• Applying masks to exposure and tone 

• Color control in highlights vs shadows 

• Tone shaping (dodging and burning) the clean way 

• Refinement checklist + practice assignment 

 

 

 

 

Snapshot Insights 

Quote 

 

 “Dodging and burning are steps to take care of mistakes God made in 
establishing tonal relationships.” -  Ansel Adams 



What a Luminosity Mask 
Really Is 
A luminosity mask is a selection based on 
brightness values — not edges, not colors, 
but light itself. 

In plain terms, you’re telling Photoshop: 
apply this adjustment only where the image 
is already bright, midtone, or dark, and let it 
fade smoothly across tones. 

• Looks invisible when done right 

• Preserves realism 

• Avoids halos and crunchiness 

• A go-to technique for high-end landscape 

work 

 

When You Should Use 
Luminosity Masks 
Use luminosity masks when you want an 
adjustment to affect only a specific tonal 
range — not the entire frame. 

• Brighten highlights without blowing them 

• Open shadows without flattening contrast 

• Add color only where light exists 

 

Rule of thumb: If an adjustment affects 
everything, it’s probably wrong. 

Part 1 — Creating 
Luminosity Masks (Manual 
Method) 

Step 1: Open the Channels Panel 
• Open your image in Photoshop 

• Go to Window → Channels 

• You’ll see RGB, Red, Green, Blue 

 

Step 2: Create a Basic Highlights 
Mask (Lights 1) 
• Ctrl/Cmd + click the RGB channel to load a 

selection based on brightness 

• Bright areas = strong selection; dark areas 

= weak or no selection 

• This is your Lights 1 mask 

 

Step 3: Refine the Highlights (Lights 
2, Lights 3…) 
To target brighter and brighter values, save 
and reload the selection repeatedly: 

• With the selection active: Select → Save 

Selection → name it “Lights 1” 

• Ctrl/Cmd + click “Lights 1” → Save as 

“Lights 2” 

• Repeat for “Lights 3” to isolate only the 

brightest highlights 

 

Step 4: Create Darks Masks 
• Load “Lights 1” 

• Select → Inverse 

• Save as “Darks 1” 

• Repeat the same narrowing process to 

create “Darks 2” and “Darks 3” 

 



Step 5: Create Midtones Masks 

Midtones are neither bright nor dark — 
subtle, but extremely powerful. 

• Load “Lights 1” 

• Load “Darks 1” while holding Alt/Option (to 

subtract) 

• Save as “Midtones” 

 

Part 2 — Applying 
Luminosity Masks to 
Adjustments 

The Golden Rule: Luminosity masks belong 
on adjustment layers, not pixel layers. 

Exposure Control (The Core Skill) 

Example: Brightening a Landscape 
Sky  

Problem: the sky looks dull or gray — 
common with flat light. 

• Load “Lights 2” 

• Add a Curves adjustment layer 

• Gently lift the curve just a little 

 

Why it works: only bright clouds and sky 
tones lift, without halos at the horizon or 
washed-out blues. 

Master tip: If you can clearly see the 
adjustment, it’s too strong. 

Example: Opening Foreground 
Shadows 

• Load “Darks 2” 

• Add Curves and lift the shadow point 

subtly 

• Add a slight S-curve to keep contrast 

 

This helps you avoid gray shadows, muddy 
blacks, and that HDR “lifted floor” look. 

Part 3 — Color Control 
Using Luminosity Masks 
Color behaves differently in light than in 
shadow. Targeting tones first is the fastest 
way to make color feel clean and intentional. 

Example: Enhancing Warm Sunset 
Color 
Common mistake: saturating the whole 
image. Better approach: 

• Load “Lights 1” 

• Add Selective Color or Hue/Saturation 

• Increase saturation slightly and nudge 

warmth toward yellow/orange 

 

Result: color shows up where light hits, 
while shadows stay neutral and clean. 

Example: Cooling Shadows Without 
Killing Contrast 
• Load “Darks 1” 

• Add Color Balance 

• Push shadows a touch toward blue/cyan 

 

This creates depth, color separation, and a 
cinematic-but-natural feel. 



Part 4 — Tone Shaping (The 
Signature Look) 

Sculpting Light (Dodging & Burning 
with Masks) 
Instead of painting white and black, use 
tonal selections for a cleaner, more 
controllable result: 

• Load “Lights 2” → Curves → gently 

brighten 

• Load “Darks 2” → Curves → slightly deepen 

shadows 

 

This builds dimensional contrast rather than 
global contrast. 

Part 5 — Mask Refinement 
Checklist 
Preview your mask (Alt/Option + click the 
mask thumbnail) and look for: 

• Smooth gradients (no banding) 

• No hard edges 

• No speckling 

 

If needed: 

• Apply a small Gaussian Blur (about 1–2 px) 

to soften transitions 

• Use Levels on the mask to tighten or soften 

the selection 

• Click the mask, then press Ctrl/Cmd + L to 

adjust Levels until the mask fits your target tones 

 

 

 

 

Final Master Principles 
Memorize these: Subtlety beats strength 
• Light controls color 
• Highlights can take saturation; shadows 
need restraint 
• If you need opacity below 20%, you’re 
probably doing it right 
• Luminosity masks should disappear — 
not announce themselves 

Practice Assignment 
Take one image and build the following 
masks: 

• Lights 1–3 

• Darks 1–3 

• Midtones 

 

Make only Curves adjustments (no global 
sliders), and stop before it looks “edited”. 

If you try this practice assignment, I would 
love to put some before and after images 
in the next newsletter. Be sure to send 
them attention Newsletter Editor at 
president@saskatoonphotographyclub.com 
 

 

Until next time—mask gently, watch 
for halos, and let the light do the 
talking. 
 
Cheryl Lalonde 

PSA Representative 
Saskatoon Photography Club 

mailto:president@saskatoonphotographyclub.com
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Canadian Association for Photographic Art (“CAPA”) 

Consider a CAPA Membership 

The mission of CAPA is to foster a vibrant and inclusive community that promotes ethical practices 

and advances the art of photography for all skill levels. We inspire and empower photographers to tell 

meaningful visual stories through creativity, education and community. 

 

By joining CAPA, you’ll gain access to a vibrant community and a wide range of member benefits:  

• Expert-led education: Participate in workshops, lectures, and series like our CAPA Speaker 
Series, Image Critique Nights, Image Editing Demos and  other Presentations.  

• Quarterly magazine: Receive the full-colour, high-quality Canadian Photography 
Magazine delivered to your door, along with online access to current and past issues 

• Exclusive competitions: Submit your work to eight CAPA-only photography competitions. 
You can also explore recent winning entries on our website. 

These are just a few of the many benefits you receive when you join CAPA.  Joining CAPA is the 
best investment in your photography you can make.  

Become a member now. https://capacanada.ca/product-category/individuals/ for a full year filled 
with learning, competitions, fellowship, new friends and inspiration - that's what we are all about.   

 

Read the latest CAPA members newsletter here: 
 
https://mailchi.mp/capacanada.ca/monthly-news-jan-2026-english?e=ce7e4a08b1 
 
 

Note: One of our own members “Cathleen Mewis” has an image featured in the newsletter! 
 
 
 
 
 
 
 
 
 
 
 
 

https://capacanada.ca/product-category/individuals/
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Unleash your Passion for Photography with the 

Photographic Society of America Worldwide 

Become a member of our global photography organization and gain access to exclusive content, enjoy discounts 

on photography gear, participate in educational workshops, and receive personalized feedback on your work. 

 

 

 

 

New & Exciting! PSA is launching a new social media photo contest. 
 

• Fresh Themes: Subject matter changes every month to spark your creativity. 

 
• Win Prizes: Winners announced on Facebook and Instagram. 
 
• How to Enter: Email your photo entry and be sure to include: 

 
• Photo title 
• Your name 
 
• Stay Connected: Follow our new Facebook page to keep up with contest updates. 
 
• See More: View the advertisement below for full details. 

  

https://xdez76mab.cc.rs6.net/tn.jsp?f=001dZxHLsX_26fq8Uee1ddAttsIIUXH-ZPwMZ3L8pCll0gL42hizXVll7zmTROmsXcultxknObmV1BPXdjL8UQwU-Vw7HY7L5oiyvCWu4KK-D4GKR-8a24YuHB-OhhHMqjrQvbxL46KUI8CdII8Nxbkd4FBMOCPexnPqzrlclZ9xNsxa4imZThOWugs2ZkKQwEbFLmoCkOAEuk=&c=C3aZ8RVemw1r68GsIHlRp_yFjApkn_upgSO9FhuuJ5ymqyj7O8LtAQ==&ch=hYtkzYMdSWNrfSwiRsKsns9KlB3r7f888XDfID0hqcF4mkTLlek6ow==
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Follow us on all our platforms  

         
 

  

  
 
 

 

 

 

 

 

 

 

 

https://xdez76mab.cc.rs6.net/tn.jsp?f=001dZxHLsX_26fq8Uee1ddAttsIIUXH-ZPwMZ3L8pCll0gL42hizXVll7zmTROmsXcultxknObmV1BPXdjL8UQwU-Vw7HY7L5oiyvCWu4KK-D4GKR-8a24YuHB-OhhHMqjrQvbxL46KUI8CdII8Nxbkd4FBMOCPexnPqzrlclZ9xNsxa4imZThOWsyBm2AR-yrOdurUyf6CUHU=&c=C3aZ8RVemw1r68GsIHlRp_yFjApkn_upgSO9FhuuJ5ymqyj7O8LtAQ==&ch=hYtkzYMdSWNrfSwiRsKsns9KlB3r7f888XDfID0hqcF4mkTLlek6ow==
https://xdez76mab.cc.rs6.net/tn.jsp?f=001dZxHLsX_26fq8Uee1ddAttsIIUXH-ZPwMZ3L8pCll0gL42hizXVll7zmTROmsXcurIL6U1m9KAQohZFNQud6bMZzjEOk9hjBFdgfRQQXQBuImsfyH6LlFt6pYZuKp1Fug5_sUL1b3XBgoRvBqvU21A==&c=C3aZ8RVemw1r68GsIHlRp_yFjApkn_upgSO9FhuuJ5ymqyj7O8LtAQ==&ch=hYtkzYMdSWNrfSwiRsKsns9KlB3r7f888XDfID0hqcF4mkTLlek6ow==
https://xdez76mab.cc.rs6.net/tn.jsp?f=001dZxHLsX_26fq8Uee1ddAttsIIUXH-ZPwMZ3L8pCll0gL42hizXVll7zmTROmsXcuJdX_AdIMASrAikbIElvHLbD2Y2Ht07ZjXn9EnHo3Km-glZpeFva8ew0HWzoZ34ZYubeekPVXBPdYpMsXKrW76KUC1l8mRrqkxkDv4GrwVSJw5oGufyM27w==&c=C3aZ8RVemw1r68GsIHlRp_yFjApkn_upgSO9FhuuJ5ymqyj7O8LtAQ==&ch=hYtkzYMdSWNrfSwiRsKsns9KlB3r7f888XDfID0hqcF4mkTLlek6ow==
https://xdez76mab.cc.rs6.net/tn.jsp?f=001dZxHLsX_26fq8Uee1ddAttsIIUXH-ZPwMZ3L8pCll0gL42hizXVll7zmTROmsXcu31F1kwf0jbgtcu6cWtlq7vUnAF0Z5DlSmc2SMAId-WF9u6a-IftERWwAnMi-PZK81erdA9lzkmGJKiQPEHP_dhtA4KWsYlnRTE6dLRXkwCj2IA3LGD5YPg==&c=C3aZ8RVemw1r68GsIHlRp_yFjApkn_upgSO9FhuuJ5ymqyj7O8LtAQ==&ch=hYtkzYMdSWNrfSwiRsKsns9KlB3r7f888XDfID0hqcF4mkTLlek6ow==
https://xdez76mab.cc.rs6.net/tn.jsp?f=001dZxHLsX_26fq8Uee1ddAttsIIUXH-ZPwMZ3L8pCll0gL42hizXVlly6Q2xoWfujz5aqzvB8oenUjeB9MwGULTQ3OdZHx_mZutGnRNg7587WbI0XFHk_rVB6k4LHpdVGVGV3sSv6241r-M9wFAWFUbOLvzYZ6FiVfhZIL5eHtgFdQEgmv-CD0DA==&c=C3aZ8RVemw1r68GsIHlRp_yFjApkn_upgSO9FhuuJ5ymqyj7O8LtAQ==&ch=hYtkzYMdSWNrfSwiRsKsns9KlB3r7f888XDfID0hqcF4mkTLlek6ow==
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SASKATOON NIGHT SKY  

 

 

 

 

 

 

 

 

A photographer-friendly calendar of the best things to shoot from the Saskatoon area—with special 
attention to moonlight, foreground-friendly timing, and quick-drive locations. 

Nightscape recipe (meteors + Milky Way) 

• Shoot long blocks (2–4 hours) for meteor stacks; keep composition simple and strong. 

• For meteors, frame 40–60° away from the radiant for longer streaks. 

• Bring a red light + spare batteries (cold kills them) + a lens cloth/hand warmers for dew. 

Don’t-miss nights in 2026 

• Tue, Mar 3 (pre-dawn): Total lunar eclipse — totality 

5:04–6:02 am (CST). 

• Tue–Wed, Apr 21–22: Lyrids peak — moon ~27%. 

• Wed–Thu, Aug 12–13: Perseids peak — moon ~0% (new 

moon). 

• Thu night, Aug 27 → Fri, Aug 28: Partial lunar eclipse — 

7:55 pm to 1:01 am; max 10:12 pm. 

• Wed–Thu, Nov 4–5: Southern Taurids — fireballs; moon 

~18%. 

• Wed–Thu, Nov 11–12: Northern Taurids — fireballs; 

moon ~7%. 

• Sun–Mon, Dec 13–14: Geminids peak — moon ~21%. 

One-hour drive shortlist 

Rule of thumb: 
• Milky Way + meteors: go south/southeast so the city 

glow is behind you. 

• Aurora: go north/northwest so your northern horizon is 

dark. 

 

• Pike Lake Provincial Park: ≈20 minutes south. Trees + 

water. 

• Blackstrap Provincial Park: ≈35 minutes 

south/southeast. Big sky + reservoir. 

• Beaver Creek Conservation Area (Meewasin): ≈13 km 

south on Hwy 219. 

• Cranberry Flats (Meewasin): day-use area; best for 

blue hour. 

Field safety & etiquette 

• Respect posted hours and private land; park fully off the road. 

• Bring extra layers + a headlamp; tell someone your plan. 
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2026 month-by-month (Saskatoon area) 

January 

• Quadrantids peak (Jan 3–4): Moon is full at peak (poor). 

• Snow foregrounds + crisp transparency can be amazing. 

July 

• Milky Way core: prime month; nights lengthen after mid-

July. 

• Delta Aquariids/Alpha Capricornids (Jul 30–31): Moon 

~98% (poor). 

February 

• Quiet month—use it for scouting and practice runs. 

• Short nights + cold: test batteries, dew control, workflow. 

August 

• Perseids peak (Aug 12–13): Moon ~0% (best meteor shoot 

of the year). 

• Partial solar eclipse (Aug 12): visible as a small partial 

(daytime). 

• Partial lunar eclipse (Aug 27–28): 7:55 pm to 1:01 am; max 

10:12 pm. 

March 

• Total lunar eclipse (Mar 3): penumbral 2:44 am; totality 

5:04–6:02 am (CST). 

• Aurora odds often improve toward the March equinox 

(≈Mar 20). 

September 

• Aurora season improves again around the September 

equinox (Sep 22–23). 

• Milky Way evenings: the core is moving earlier—great for 

earlier-night shoots. 

April 

• Lyrids peak (Apr 21–22): Moon ~27% (good). 

• Milky Way core starts showing pre-dawn late month. 

October 

• Long, dark nights return: excellent for aurora + fall 

foregrounds. 

• Orionids peak (Oct 21–22): Moon ~80% (lower priority). 

May 

• Milky Way season: pre-dawn core; aim south/southeast 

from dark sites. 

• Noctilucent clouds may begin late month—watch N/NW in 

twilight. 

November 

• Southern Taurids peak (Nov 4–5): Moon ~18% (good). 

• Northern Taurids peak (Nov 11–12): Moon ~7% (excellent). 

June 

• Noctilucent clouds: prime season (June–July). Look low to 

the north in twilight. 

• Milky Way core is strong, but nights are short near the 

solstice. 

December 

• Geminids peak (Dec 13–14): Moon ~21% (excellent). 

• Ursids peak (Dec 21–22): Moon ~94% (poor). 
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SHUTTER SHOP 
Welcome to the shutter shop. This section is reserved for buying 
and selling your gear/camera equipment. It is not meant to be for 
selling services or advertising businesses. ISO (in search of) is the 
equipment wanted section and Flash Sale Finds is the for-sale 
section. If you have something to list, please email a description, 
1 picture and your contact details to: 

info@saskatoonphotographyclub.com 

ISO  

 

 

 

Flash Sale Finds 


